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Sažetak 

Trapping je postupak dodavanja blagog preklapanja između boja koje se dodiruju kako bi se 

izbjegle praznine uzrokovane odstupanjem u registru. Prilikom tiska uslijed pritiska i drugih 

uvjeta u tisku (vlaga, temperatura) dolazi do dimenzionalnih promjena na tiskovnoj podlozi što 

dovodi do pogreške u registru tiska kreirajući tako izbijanje bjelina, odnosno površine papira na 

kojem se otiskuje a vidljivo je ljudskom oku u konačnoj reprodukciji. Pogreške u registru se 

smanjuju i eliminiraju primjenom trappinga. Najčešći načini izrade trappinga su ručno pomoću 

DTP alata, pomoću softvera za automatski trapping i In-RIP trapping.  

 

Ovim radom je opisan problem lošeg registra, osnovni uzroci uslijed kojih dolazi do pojave 

tankih praznina u procesu tiska te postupak trappinga kao metoda kompenzacije tih nenamjernih 

odstupanja. Također su prikazane trapping tehnologije koje omogućavaju jednostavniju i bržu 

primjenu trappinga u pojedinim alatima. Pogreške i rješenja su potkrijepljena praktičnim 

primjerima, opisnim dijelom, te popratnim slikama istih. 

 

Rad je koncipiran na način da su teorijski i praktični dio spojeni to jest nakon teorijskog 

objašnjenja dolazi praktični dio koji prati teoriju. 

 

U praktičnom dijelu primjenom DTP alata izrađeno je šest konkretnih primjera amabalažnih 

proizvoda u procesu grafičke pripreme. Primjeri primjene trappinga izrađeni su manualno 

pomoću Adobe DTP alata te automatski pomoću Esko Power trappera.Usporedbom primjene 

trapping manualnim i automatski načinom utvrđen je stupanj kvalitete konačne reprodukcije. 

 

Ključne riječi: trapping, registar tiska, DTP alati, softver za automatski trapping, In-RIP 

trapping, pogreške, rješenja, ambalaža 

 



 

Popis korištenih kratica 

PDF Portable Document Format 

Ctf Computer to Film 

CPU           Central Processing Unit 

CMYK       cyan, magenta, yellow, black (zeleno-plava, purpurna, žuta, crna) 

RIP             Raster Image Processor 

DTP            Desktop publishing 

Ctp              Computer to Print, Computer to Plate, Computer to Press 

TIFF           Tagged Image File Format 

PJTF           Portable Job Ticket Format 

JDF             Job Definition Format 

RGB            red, green, blue (crvena, zelena, ljubičasto-plava) 

PS                PostScrip 
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1. Uvod 

Grafička priprema za tisak podurazumijeva niz stručnih radnji pomoću kojih dizajnerska 

rješenja dovodimo do konačnog tiskanog ili promotivnog proizvoda. Za kvalitetnu izradu i 

pripremu grafičkih materijala za tisak, osim poznavanja i vladanja računalnim alatima potrebno 

je poznavati i sam proces tiska, tiskarske norme, tehnologiju i terminologiju. Tek poznavanjem 

cjelokupnog procesa proizvodnje moguće je smanjiti mogućnost pogrešaka i eliminirati greške 

koje se javljaju u pripremi, tisku ili doradi, a redovno su vrlo skupe.  

 

Isključivo pravilnom grafičkom pripremom za tisak moguće je gotovo eliminirati eventualne 

pogreške koje bi mogle nastati pri procesu tiska. 

 

U kolor tisku postoje višestruke mogućnosti pojave pogreške u registru tiska. Svaki put kada 

tiskovna podloga prolazi kroz stroj za tisak, postoji mogućnost pojave pomaka u registru tiska, 

ukoliko je došlo do dimenzionalne deformacije tiskovne podloge za vrijeme tiskovnog procesa 

[10]. 

 

Kao rezultat, javljaju se tanke praznine između dviju boja koje su otisnute jedna do druge. 

Unatoč tome što su male, te praznine su posebno zbunjujuće za ljudsko oko (vidi sliku 1.1.). 

Kako bi riješili ovaj problem, u pripremu se uvodi tehnika zvana trapping. Trapping je 

namjerno preklapanje boja duž zajedničke granice dvaju dodirujuća ili preklapajuća objekta, 

kako bi se spriječile tanke bijele praznine u slučaju pomaka uzrokovanog lošim registrom tiska 

tijekom procesa tiska [20]. 

 

 

 

 

 

 

 

 

 

Slika 1.1. Pogreška u registru tiska bez primjene trappinga (lijevo) i sa trappingom (desno) 
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2. Pogreške u registru tiska 

Prilikom tiska povremeno dolazi do pogrešaka u registru tiska. U praksi je nemoguće 

ostvariti tisak bez utjecaja lošeg registra za svaki objekt na pojedinoj tiskovnoj podlozi. Iste 

pogreške u registru se očituju kao nenamjerne praznine između boja. 

Problem lošeg registra tiska može uzrokovati nekoliko faktora, a neki od njih uključuju:  

- distorziju tiskovne forme 

- nepreciznost u izradi tiskovne forme na Ctf-u ili Ctp-u 

- deformacija tiskovne podloge 

- nepreciznost osvjetljivača slika 

- velika brzina tiska 

- ljudske pogreške [9] 

2.1. Uzroci pojave lošeg registra 

Kako je navedeno u tekstu ranije, nekoliko faktora uzrokuje pojavu tiska pojedinih boja izvan 

registra što rezultira pojavom praznina i pomakom boja između objekata. 

2.1.1. Distorzija tiskovne forme 

Negativi mogu biti ispravno proizvedeni, ali postoji mogućnost da dođe do dimenzionalne 

deformacije istih, što rezultira pojavom pogreške u registru tiska kod otiskivanja pojedinih 

separacija boja.  

Također, ako je tiskovna forma proizvedena na pogrešan način, slika na tiskovnoj formi 

postane iskrivljena, što rezultira pojavom pogreške u registru tiska pojedinih boja prilikom tiska 

[9]. 

Promjene u temperaturi ili vlazi tijekom izrade tiskovne forme može dovesti do pojave lošeg 

registra [31]. 

2.1.2. Nepreciznost u izradi tiskovne forme 

Kod ručne montaže pogreške u registru tiska su izraženije zbog utjecaja ljudskog faktora. 

Čak i u slučajevima kad je u radu prisutna najveća količina pažnje, pogreške u montaži pomoću 

grafičkog filma mogu dovesti do pojave lošeg registra [47]. 
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Ponekad pritisak vremenskih rokova tjera operatere na ubrzavanje strojeva za tisak koji tada 

prave veći broj pogrešaka.  

2.1.3. Deformacija tiskovne forme 

Tijekom procesa otiskivanja tiskovna podloga putuje kroz više tiskovnih jedinica koje 

sekvencijalno otiskuju različite separacije boja na tiskovnu podlogu, što često zna dovesti do 

dimenzionalne deformacije tiskovne podloge. Takve promjene u dimenzijama mogu uvelike 

utjecati na registar u procesu otiskivanja [16]. 

Čimbenici koji najviše utječu na dimenzionalnu stabilnost tiskovne podloge su [9]: 

 uvjeti tiska - distorzija tiskovne podloge uzrokovana utjecajem tlaka, temperature i 

vlage iz atmosfere 

 površinska obrada tiskovne podloge - površina tiskovne podloge premazana ili 

nepremazana 

 Papir može uzrokovati pogrešku u registru ako je neispravno proizveden. Ukoliko 

njegov afinitet za vodu nije kontroliran u proizvodnji, papir može promijeniti veličinu 

u tisku i pritom uzrokovati pogreške u tisku. 

 Odskakivanje ili pomicanje papira može uzrokovati pogrešku. Česti uzrok izbacivanja 

papira iz registra je primjer udaranja lista o hvataljke za zahvaćanje tiska, pri čemu 

papir lagano odskoči unatrag prije samog zahvaćanja. 

 gramatura - podložnost rastezanju veća kod manjih gramatura tiskovne podloge 

 broj prolaza kroz stroj 

 nedosljedna kvaliteta tiskovne podloge 

 prihvaćanje svježe otisnutog bojila na prethodno otisnuto bojilo - u višebojnom tisku 

postoji značajna razlika u otisku koji je nastao nanošenjem bojila na osušenu podlogu 

(mokro na suho), i na neosušenu podlogu (mokro na mokro) 

 Također u višebojnom tisku, list se prenosi od jedne tiskovne jedinice do druge pri 

čemu dolazi do mogućnosti odskakivanja papira između izmjena. Ako je tisak 

pogrešno postavljen ili je prevelika brzina otiskivanja od optimalnih uvjeta ispisa, 

pogreške registra će se javljati učestalije. 

 Stanje strojeva i uvjeti u kojima se tiska također dovodi do pogrešaka. Ako strojevi 

nisu pravilno održavani, tisak postaje samo čimbenik u lošem registru, stvarajući 

probleme u napuštanju boje. 
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Pogreške u registru tiska se mogu manifestirati na nekoliko načina. 

 

 

Izgled objekta prije tiska u digitalnom obliku. 

 

 

Ukoliko dođe do pojave pogreške u registru tiska, 

crveni objekt se pomakne u stranu, stvarajući 

djelomični prikaz bijelog papira kroza nj. 

 

Također se pojavljuje tamni obrub, gdje se crveni 

objekt i plava podloga preklapaju. 

 

 

Slika 2.1. Izbijanje podloge (eng. knockout) 

 

Pretjerana pogreška u registru tiska je očita kad se boje u slici pojavljuju mutno, ali tipično 

pogreška registra je puno više suptilna. Kada boje nisu u registru, rubovi dodirujućih boja ili se 

preklapaju, stvarajući neatraktivan presjek boja odnosno neku treću boju ili se proširuju, 

stvarajući tanku prazninu [1] (slika 2.1.). 

Na slici 2.1. prikazan je slučaj pojave neotisnutih dijelova tiskovne podloge kada dođe do 

pomaka boja uzrokovanog utjecajem lošeg registra. 

 

Sličan problem koji nastaje uzrokom lošeg registra je neželjeno preklapanje boja. Ovaj slučaj 

može rezultirati pojavom boje koja je upadljivo drukčija od boja koje su trebale biti prisutne.  
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Slika 2.2. Preklapanje boja 

 

Na slici 2.2. prikazana je pojava preklapanja boja prilikom tiska žutog teksta preko magenta 

podloge, što rezultira pojavom treće (smeđe) boje na mjestu gdje se navedene dvije preklapaju 

(uveličano na slici 2.2.).  

 

Sljedeći problem prikazuje utjecaj bijele boje na crnoj pozadini (vidi sliku 2.3.).  

Slika 2.3. prikazuje učinak bijele boje nasuprot duboke crne boje. Ako tisak izađe van 

registra, slova su ugrožena, manji dijelovi postaju nečitki, gotovo nevidljivi (uveličano na slici). 

 

 

 

 

 

 

 

 

 

 

 

Slika 2.3. Utjecaj bijele boje na crnoj podlozi 
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2.2. Rješenje problema pogrešaka u registru tiska 

Trapping uvodi korektivne elemente boja u tisak. U procesu izrade trappinga, dodaju se novi 

elementi koji stvaraju generirano preklapanje između boja. Generirano preklapanje boja 

kompenzira potencijalne probleme koji bi mogli nastati uslijed djelovanja lošeg registra tiska. 

Trapping elementi su obično generirani na jednaku veličinu, pružajući svojstva boja koje će 

prekriti ili ispraviti pogreške u tisku ukoliko se pojave. 

Trapping sustav uvodi mikroskopske elemente na način u kojem su oba sofisticirana i 

iznenađujuće suptilna. Ispravno generiran element je pravog oblika i boje. 

Današnji kreativni projekti tiska iziskuju trapping elemente koji su više kompleksni i trapping 

tehnike koje su naprednije od onih korištenih u prošlosti. S gradijentom, metalik bojama i 

izvanrednim kombinacijama umjetničkih elemenata, trapping je postao jednostavniji i 

pristupačniji nego što je to bio u prošlosti. Adobe trapping tehnologije primjenjuju precizne 

vektorske analize na svim sukladnim operacijama kako bi kombinirali prednosti raster i vektor 

trappinga [1].                                                          

Trapping temeljen na rasteru daje precizne boje i opis stranica dok trapping temeljen na 

vektoru pruža brzinu i kvalitetno trapping oblikovanje [2]. 

Ispravljanje pogrešaka ne bi trebalo stvarati nove probleme. Ukoliko je trapping dobro 

odrađen, novi tiskani elementi se neće vidjeti; oni riješe problem i dalje ostaju nevidljivi u 

procesu. Prekomjerno korištenje trapping elemenata može postati vidljivo i stvoriti više 

problema od onih koje su trebali riješiti.  

Jednostavni trapping elementi su proširivanje (eng. spread) i upuštanje (eng. choke) (vidi sliku 

2.4.).  

 

 

 

Žuti objekt je svjetliji od okolne pozadinske boje. 

Trapping element se proširuje u tamniju boju. 

 

 

Žuti napust je postavljen kao  pretisak na boju 

pozadine, te sprječava nastanak bijelih praznina. 
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Središnji objekt je tamniji od okolne boje 

pozadine. Trapping element se sužuje u tamnoj boji. 

 

 

 

 

 

 

 

Slika 2.4. Eliminacija utjecaja tolerancije registra tiska 

 

Na gornjem primjeru slike 2.4. žuti objekt se proširuje u crni objekt kako bi eliminirao 

pogrešku u registru tiska. Na istom primjeru dolje, žuta boja pozadine se upušta u crni objekt. U 

oba slučaja bi se žuti trapping element podlagao crnom bojom (eng. overprint), što u konačnoj 

reprodukciji ne bi bilo vidljivo kao što je to u ove dvije ilustracije.  
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2.3. Trapping elementi 

 Gradijent 

Gradijent je izazov za bilo koji trapping sustav iz razloga što se boje i njihove vrijednosti 

mijenjaju ovisno o području prijelaza, te odnos između gradijenta i njegove pozadine 

konstantno varira. Prije nastanka današnjih tehnologija pripreme za tisak, ovaj problem 

gradijenta je bilo nemoguće riješiti. S novom Adobe trapping tehnologijom, gradijent 

može biti učinkovito i lako riješen [1].  

 Gradijent na gradijentu 

Trapping na jednobojni gradijent je lako primijeniti, najčešće je to preklapanje boja u 

liniji gdje ne dolazi do promjena boja. Naime, izazov je kada dolazi do preklapanja dvaju 

gradijenta, pri čemu će se svjetlija boja promijeniti kada dođe u kontakt sa gradijentom 

[1] (vidi sliku 2.5.).  

 

 

 

 

 

 

 

 

Slika 2.5. Primjer trappinga jednog gradijenta na drugi 

 

U gradijentima prikazanim na slici 2.7. izazov je preklopiti dvije boje iz razloga što se 

njihove vrijednosti kontinuirano mijenjaju.  

 Prijelazni trapping 

Adobe trapping tehnologije koriste sofisticirane trapping elemente za preklapanje boja 

kod kompleksnih gradijenata,koji se još nazivaju prijelazni trapping. Ova tehnologija 

omogućuje da se izbjegnu nagle promjene kod sličnih boja koje su slične neutralne 

gustoće, pritom stvarajući glatke prijelaze [1,12] (vidi sliku 2.6.).  
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Slika 2.6.Prijelazni trapping 

 

Slika 2.6., gornja slika prikazuje tradicionalni trapping, koji je direktan, te zbog toga lako 

uočljiv. Prijelazni trapping (donja slika) je mnogo suptilniji i učinkovitiji. 

 Metalik i spot boje 

Spot ili metalik boje u dizajnu često predstavljaju velike probleme ukoliko dođe do 

situacije da je potrebno koristiti trapping metode. Ako su u dizajnu uključene neprozirne 

tinte, poput metalnih tinta, potpuno opremljena Adobe tehnologija uspješno koristi 

trapping rješenja na temelju prikupljenih znanja, po redu kako su tinte tiskane. Ovaj 

procesosigurava preklapanje boja u smjeru koji zadržava oblik izvornog dizajna [1]. 

 Slika i gradijent 

 

 

 

 

 

 

 

Slika 2.7. Trapping gradijenta procesnih boja (slika lijevo) i trapping slike u gradijentu procesne boje 

(slika desno) 
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Sposobnost sofisticiranijih trapping sustava dolazi u pitanje kada imamo sliku na 

gradijentu ili obrnuto. Primjer na lijevoj slici će ostati nepromijenjen ukoliko trapping 

gradijent procesnih boja prebacimo u gradijent spot boja (vidi sliku 2.7.). U primjeru na 

desnoj strani, na sliku će biti primijenjen trapping gradijenta procesne boje (vidi sliku 

2.7.). 

 Slika na slici 

Slika na slici jest dosta komplicirana, iz razloga što trapping sustav analizira križanja 

između slika i stvara pravilne trapping metode u boji kako bi se spriječila pogreška u 

registru i kako se ne bi prikazala na otisnutoj tiskovnoj podlozi. Taj trapping element je 

određen analizom vrijednosti piksela cijelim dijelom interakcija dviju slika. Element 

trappinga sprječava nastanak problema bez privlačenja pozornosti na sebe (vidi sliku 2.8.) 

[1]. 

 

 

 

 

 

 

 

 

 

Slika 2.8. Trapping slike na pozadinu druge slike 

 

 Trapping duboke crne 

Princip tiska crne boje često uključuje stvaranje duboke ili tamne crne. Duboka crna se 

dobiva miješanjem cijan, magente i žute s crnom kako bi se dobila duboka, to jest tamna 

crna u procesu tiska. Da bi se stvorila duboka crna u kolor (cmyk) tisku potrebno je 

odrediti sljedeće vrijednosti: cijan 40%, magenta 40%, žuta 40% i crna 100%. Duboka 

crna se ne koristi za tisak tekstova [60]. 

Dodatni tonovi boja ispod crne čine crnu bogatijom i atraktivnijom na  konačnoj 

reprodukciji [1]. 
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3. Primjena trappinga u grafičkoj reprodukciji 

Kako je već poznato u tiskarskoj struci, teško je postići i zadržati savršenu razinu tiska bez 

pogrešaka u registru tiska. Prilikom tiska gotovo uvijek nastaju vidljive greške u obliku bjelina 

odnosno praznina, uzrokovane raznim smetnjama i neusklađenostima u separaciji boja (vidi sliku 

3.1.). Kod dodirivanja boja često se koristi preklapanje boja (eng. trapping) kako bi greške u 

registru tiska bile manje vidljive [47].  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pogreška u registru tiska bez trappinga         pogreška u registru tiska sa trappingom 

 

Slika 3.1. Kompenzacija praznine i pomaka boje 

3.1. Osnovne metode trappinga 

Kada nije moguće izbjeći dodirivanje boja i kad dodavanje crnog obruba oko elementa nije 

izvediva opcija, potrebno je uvođenje trappinga prilikom izrade grafičke pripreme. Ukoliko je 

dizajner neiskusan u ovom području ili ima složenu ilustraciju na kojoj radi, najbolja je 

preporuka da postupak trappinga provede neko iskusniji. U protivnom, dizajner bi trebao ručno 

izraditi trapping pomoću DTP alata [11]. 

Prije nego što se krene s postupkom izrade trappinga, potrebno je poznavati osnovnu 

terminologiju vezanu uz trapping i metode primjene istih. 

 



 12 

3.1.1. Podlaganje boja (eng. Overprint) 

Podlaganje boja odnosno overprint predstavlja tisak boje koja se nalazi naprijed preko ostalih 

boja u pozadini. Ovisno o samim bojama, na mjestima gdje se boje preklapaju, dobivaju se 

nijanse boja koje nastaju miješanjem u tisku [9]. 

Ako su boje pokrivne, na reprodukciji neće doći do pojave zamjetljivih promjena u tonu boje 

na mjestu preklapanja zadanih boja. Ukoliko su boje prozirne (kao što je većina), dolazi do 

pojave novih boja na mjestima preklapanja zadanih (vidi sliku 3.2.) [16].  

Podlaganje boja overprint se koristi u sljedećim situacijama: 

 kada imamo sitne elemente (tekst) definirane crnom ili nekom drugom posebnom 

bojom. Takvi elementi se zbog svoje veličine ne mogu izbijati te se tiskaju na 

podložnu boju neovisno o promjeni nijanse. Ovaj način izrade overprinta je češći kod 

tamnijih pokrivnih boja 

 kada namjerno želimo da nam se neka prednja boja miješa s pozadinom, tada ju 

definiramo kao overprint. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 3.2.  Podlaganje boja (eng. overprint) 
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Slika 3.3. Izgled objekta sa overprintom i bez overprinta 

 

Primjeri iznad prikazuju situaciju bez overprinta (slika dolje) i sa magenta i žutim 

overprintom (slika gore). Na gornjem primjeru vidljiva je promjena u tonu boja zvijezda na 

mjestima preklapanja zadanih boja (vidi sliku 3.3.). 

3.1.2. Izbijanje podloga (eng. Knockout) 

Prilikom izvedbe separacija boja za dokument s preklapajućim bojama, prednji objekt izbija 

boje pozadinskog objekta. Odnosno prednji objekt se otiskuje, dok se bilo koje boje ispod njega 

ne otiskuju, tako da se prilikom otiskivanja konačne reprodukcije, boje korištene za izvedbu 

prednjeg objekta tiskaju direktno na tiskovnu podlogu [9]. 

Kada su tiskovne ploče ispravno postavljene, prednji objekt savršeno ''sjeda'' u izbijeni dio 

pozadinskog objekta. Postoji mogućnost pojave pogreške u registru tiska pri čemu je prednji 

objekt blago pomaknut iz izbijenog dijela podloge, stvarajući tanke praznine. Ukoliko dođe do 

pomaka samih boja, izbijanje podloge (eng. knockout) može zahtijevati primjenu trappinga kako 

bi se uklonio mogući utjecaj lošeg registra tiska [16]. 
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Na donjoj slici cyan zvijezda izbija magenta podlogu i pritom ostavlja bijeli prostor za 

otiskivanje cyan zvijezde (slika3.4.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 3.4. Izbijanje podloge (eng. knockout) 

 

3.1.3. Proširivanje (eng. spread) i upuštanje (eng. choke) 

Kako bi se kompenzirao utjecaj pogreške u registru tiska, potrebno je stvoriti preklapanje 

dodirujućih boja na rubovima objekata. Ukoliko dođe do malog pomaka uslijed utjecaja 

pogreške u registru tiska, neće se pojaviti tanke praznine odnosno bjeline između pojedinih boja 

[8]. 

Postoje dva slična termina za opis metoda izrade namjernog preklapanja boja koje se 

dodiruju, a to su proširivanje (eng. spread) i upuštanje (eng. choke). Pravilo jest da se kod 

primjene ovih metoda svijetla boja proširuje prema tamnoj pozadini, odnosno sužava prema 

tamnijoj prednjoj boji ili ukoliko dođe do preklapanja punog tona sa svjetlijom i tamnijom bojom 

preporuča se kombinacija proširivanja i upuštanja [8,33]. 
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                      Slika 3.5. Proširivanje [33]                    Slika 3.6. Upuštanje [33] 

 

Proširivanje (eng. spread), se odnosi na primjenu trappinga na svjetliju boju u odnosu na 

tamniju boju pozadine. Na slici 3.1. svjetliji objekt preklapa tamniju boju pozadine te izgleda kao 

da se širi u pozadinu kako bi odradila trapping bez korištenja treće boje [16].  

Upuštanje (eng. choke), se odnosi na primjenu trappinga na tamniju boju iznad svjetlije 

pozadinske boje. Kod upuštanja, svjetlija boja pozadine se sužava prema tamnijoj prednjoj boji, 

koja pada u drugi plan te se čini kao da se taj isti objekt smanji (vidi sliku 3.2.) [16]. Ne koristi se 

treća boja. 

 Određivanje svjetlije/tamnije boje  

Ponekad je teško odrediti da li je boja objekta svjetlija u odnosu na pozadinsku boju ili 

obrnuto. Postoji mnogo načina određivanja svjetlije/tamnije boje. 

Najjednostavniji je način da se boje ispišu, a zatim se fotokopiraju. Time su boje pretvorene u 

crno-bijelu sliku (engl. grayscale) i mogu biti vizualno analizirane s obzirom na relativnu 

prisutnost tamnoće (vidi sliku 3.7.) [9]. 

 

Slika 3.7. Određivanje svjetlije/tamnije boje 
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Prikazane tablice su dobivene u Photoshopu, tablica boja s lijeve strane je izrađena prva kako 

bi prikazala osnovne boje RGB i CMYK sustava kod njihovih 100%-tnih vrijednosti.  

Tablica s desne strane daje prikaz boja s obzirom na relativnu prisutnost tamne komponente. 

Kod percepcije boja ključnu ulogu ima komponenta subjektivnosti. Na primjer, ukoliko je 

svjetlija boja prislonjena uz tamniju, može se pojaviti tamnija od svoje stvarne vrijednosti. Iz tog 

razloga, ove se tablice mogu primijeniti samo u specifičnim situacijama. 

Sljedeća metoda utvrđivanja svjetlije/tamnije boje se odnosi na utvrđivanje njezine neutralne 

gustoće (engl. Neutral Density). Vrijednosti neutralne gustoće su industrijski standardi za 

gustoću očitanja boja na temelju njihovih CMYK komponenti. 

Treća metoda koristi RGB komponente za određivanje relativne tame primjenjujući sljedeću 

formulu: 

Sjajnost=0,3(vrijednost crvene) +0,59(vrijednost zelene) +0,11(vrijednost plave) (1) 

3.2. Osnovna pravila trappinga 

Kod primjene trappinga potrebno je pridržavati se nekoliko pravila. 

 

Kada preklapani obojeni objekti dijele zajedničku boju, trapping je nepotreban, iz razloga što 

boja, koja je zajednička obojici elemenata stvara automatski trapping. Na primjer, ako dva 

objekta koja se preklapaju sadrže cyan kao dio njihove CMYK vrijednosti, bilo koja praznina 

između njih će biti prekrivena cyan sadržajem objekta koji je ispod.  

 

Trapping se koristi u sljedećim situacijama: 

 Uvijek između dviju spot boja 

 Uvijek između procesne i spot boje 

 Između dvije procesne boje, ukoliko ispunjava ove uvjete: 

- (a) postoji apsolutna razlika od najmanje 5% udjela tinte; 

- (b) relativna razlika je veća od limita koraka relativne boje; 

- oba (a) i (b) moraju biti istinita za najmanje dvije boje u suprotnom smjeru [4].

  

Trapping nije potreban ukoliko se koriste četiri boje u procesu, kada je korišteno podlaganje 

boja (eng. overprint) ili kada su već postavljene bijele ili crne margine oko objekta [9]. 
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Također trapping nije uvijek potreban ukoliko dvije susjedne boje dijele određeni postotak 

boja. Prijelazi između parova boja koji imaju većinu svojih komponenti na različitim 

separacijama su ključni cilj trappinga [9]. 

 

 

 

 

 

 

 

 

 

Slika 3.8. Upotreba procesnih boja s određenimpostotkom zajedničkih boja 

 

Na primjer ako svaki objekt dijeli barem 20% magente, bilo kakav pomak uzrokovan 

pogreškom u registru tiska će rezultirati prazninom s manjim postotkom magente. U nekim 

slučajevima ovakva je situacija prihvatljiva i ne baš previše primjetljiva (vidi sliku 3.8.) Što je 

postotak zajedničkih boja bliži, manja je potreba za trappingom [9]. 

 

 

 

 

 

 

 

 

 

 

Slika 3.9. Upotreba procesnih boja s malim postotkom zajedničkih boja 

 

Na primjeru slike 3.9. simulirana je situacija što bi se dogodilo ukoliko je kod tiska separacija 

žute došlo do pomaka uslijed pogreške u registru tiska.  

Primjena trappinga je potrebna ukoliko se postoci zajedničkih boja toliko razlikuju da uslijed 

pogreške registra u tisku daju treću boju (vidi sliku 3.9.). Komponente žute boje zahtijevaju 

primjenu trappinga iz razloga što se dovoljno razlikuju da bi uslijed djelovanja pogreške u 

registru tiska došlo do pojave treće boje.   
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 Kako bi izbjegli ovu situaciju, potrebne su sljedeće mjere: 

 Izbjegavanje slaganja susjednih boja koje su jako različite. 

 Primjena crnih obruba na prijelaze između boja na koje bi inače trebalo primijeniti 

trapping. 

 Umetanje praznina ili bjelina između boja koje se ne smiju preklapati. Te bjeline bi 

trebale biti manje vidljive od pomiješanih boja do kojih će doći kada se susretnu 

svijetle boje kao što je žuta i tamne boje kao što je plava. 

 Kod napuštanja boja, svjetlija boja migrira ili prelazi u tamniju boju. Tamnija boja je 

dominantna boja. S obzirom da se svjetlija boja napušta, tamnija boja zadržava 

integritet slike [9]. 

3.3. Radni slijed trappinga (eng. Trapping workflow)  

Danas korisnici mogu koristiti trapping datoteke na nekoliko načina. U najčešćoj praksi 

koristi se softverski/ručni trapping sa grafičkim alatima poput Adobe Illustrator, InDesign, 

Photoshop, Macromedia FreeHand ili QuarkXPress-u. Kod ručne primjene trappinga pomoću 

alata za DTP, trapping se ručno stvara dodavanjem obruba objektima te definiranjem overprinta. 

Softveri kao što su Adobe InDesign, PageMaker ili QuarkXPress daju mogućnost automatske 

primjene trappinga, bilo na odabrane objekte ili na cijeli dokument. Druge trapping alternative 

uključuju konkurentne in-RIP trapping rješenja (temeljene na rasterskoj i vektorskoj grafici) ili 

trapping aplikacije koje se pokreću na odvojenim radnim programima ili plug-in softverima [11]. 

Međutim, ova rješenja imaju svoja ograničenja te ne dopuštaju korisnicima da iskuse već 

predvidljive i konzistentne metode definiranja trappinga. Tako trapping aplikacija dozvoljava 

korisniku da koristi trapping elemente samo u izvornoj aplikaciji; posebno uvezeni elementi i 

slike se ne uzimaju u obzir. Trapping se određuje po sistemu rada objekt-po-objekt, te je 

vremenski vrlo zahtjevan i zahtjeva česte intervencije korisnika [11].  

Trapping rješenje na bazi servera omogućava izradu trappinga svih elemenata u jednom 

dokumentu.   

Ovakav vid trappinga mora biti dovoljno fleksibilan da bi bio kompatibilan sa drugim fazama 

digitalnog radnog slijeda, a da pritom zadrži visoku kvalitetu za oslikavanje i pregled.  

Današnji sistemi za produkciju ispisa idu prema automatiziranim i distribuiranom načinu rada 

koristeći kombinaciju PostScript i PDF datoteka. Po tom najnovijem načinu, izvode se pripreme 

uređaja za ispis – u PostScript RIP. To uključuje radove kao što su odvajanje boja, polaganja, i 

naravno trapping [11]. 
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4. Trapping tehnologije 

Ukoliko dođe do potrebe primjene trappinga, postoji mogućnost da se to odradi ručno (eng. 

manual) ili taj posao za nas automatski odradi pisač (eng. automatic). Najčešće korištena tehnika 

jest automatski trapping, iz razloga što iziskuje manje znanja, efikasnija je i puno brža [15]. 

 U daljnjem tekstu automatski trapping je podijeljen na dvije tehnike koje se najčešće koriste, 

PDF Trapper i in-RIP trapping.   

Međutim, uvijek postoji mogućnost da se i automatskom trappingu ''podvuče'' pokoja 

pogreška ili javi problem koji se ne može riješiti, tada koristimo ručni trapping. Ručni trapping 

podrazumijeva određeno znanje i vještinu korištenja alata za oblikovanje stranica. Neki od DTP 

alata koji raspolažu sa ručnim načinom izrade trappinga su Adobe Illustrator, Adobe InDesign i 

Adobe  Photoshop. 

4.1. Radni slijed Adobe Trappinga 

Kada je proizvedena trapping tehnologija isključivo dizajnirana za Adobe princip rada, 

korisnici su mogli izvršiti trapping u raznim segmentima digitalnog radnog slijeda. U usporedbi 

sa trapping rješenjima, koji omogućuju jednostavan način rada, izbor Adobe trapping načina rada 

se može prilagoditi potrebama korisnika. Izbor ovisi o tipu posla i izboru prema načinu rada za 

ispis (vidi sliku 4.1.) [1,11]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.1. Radni slijed Adobe trappinga 



 20 

4.2. In-RIP Trapping 

Premda su gotovo svi grafički softveri ograničeni primjenom trappinga na izvorne elemente 

(elementi generirani unutar samog softver), nemaju mogućnost primjene trappinga na uvezene 

elemente i često nisu u mogućnosti primijeniti trapping između izvornih i uvezenih elemenata. 

In-RIP trapping nema takvih ograničenja, što znači da bez obzira da li je element u dokumentu 

izvoran ili uvezen, može biti primijenjen trapping. Razlog tome je što se odluke o provođenju In-

RIP trappinga donose na temelju obilježja boja. Iz toga razloga, In-RIP trapping je mnogo bolje 

rješenje od aplikacijski baziranog trappinga [12].  

 

Pojam RIP je skraćenica od raster image processor, a odnosi se na unutarnji softver kojim su 

opremljeni određeni uređaji za osvjetljavanje. In-RIP trapping je daleko najlakša trapping 

metoda, iz razloga što se nakon unosa parametra trappinga, trapping odvija automatski bez 

potrebe za daljnjom intervencijom.    

 

Trapping alati se mogu razvrstati u dvije osnovne kategorije: rasterski i objektni trapping.  

Rasterski analiziraju trapping (preklop) na temelju pixel–po-pixel  gdje svaki pixel u 

rasteriziranoj stranici podliježe trappingu.. Objektni rade na Postscript jeziku ili vektorskim 

objektima koji opisuju stranicu. To znači da imaju znatno manji broj proračuna u odnosu na 

rasterski prilikom odlučivanja gdje treba smjestiti trapping, te su stoga znatno brži od rasterskih. 

Osim toga, trapping temeljen na objektima, poboljšava kvalitetu i točnost oblika preklopa [11]. 

4.2.1. Radni slijed Adobe In-RIP Trappinga 

Slika 4.2. Radni slijed Adobe In-RIP trappinga 
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Najjednostavnije rješenje za Adobe trapping tehnologiju jest Adobe PostScript 3 RIP koji 

uključuje Adobe in-RIP trapping. Unutar in-RIP trappinga korisnik ne treba mijenjati postojeći 

radni slijed. Korisnik jednostavno ispisuje na izlazni uređaj uobičajenim načinom; trapping je 

izrađen na datoteci kao dio PostScript interpretacijskog procesa (vidi sliku 4.2.).  

 

Adobe In-RIP trapping pruža mnoge prednosti radnog slijeda, uključujući [11,12]:   

 Podršku za AdobePostScript 3 i PDF printanje. Uključuje podršku za sve PostScript 3 

mogućnosti, uključujući sjenčanje (eng. smooth-shading), DeviceNcolorspace i 

maskirane slike (eng. maskedimages).  

 Automatizacija– nakon što korisnik specificira parametre za trapping, trapping se 

automatski primjenjuje na odabrani medij (papir, karton, film).  

 Brzina - učinkovita uporaba CPU-a i procesni resursi sustava, koji je integriran sa 

PostScript interpretacijskim procesom, umanjuje protok ukupnog vremena tiskanja.  

 Kvaliteta - In-RIP trapping generira preklop boja svih elemenata u dokumentu, 

uključujući sve potrebne značajke kako bi stvorio kvalitetan trapping. Uključuje 

podršku za neograničenu prilagodbu boja i lakova i podržava duboku crnu, gradijent i 

trapping slika te prijelazne preklope boja.  

 Jednostavnost korištenja - dosljedno korisničko sučelje je dostupno u nekoliko 

desktop aplikacija. In-RIP trapping je jednostavno integrirati u postojeći tijek rada 

tiskovne produkcije bez potrebe sveobuhvatne ili namjenske pripreme za tisak ili 

dodatne kvalifikacije. 

4.2.2. Harlequin Trap Pro  

HarlequinTrapPro je objektno bazirani trapping uređaj koji koristi Device-OrientedDisplay 

List koji je integriran u Harlequin RIP. Time se omogućuje da uređaj primjenjuje trapping na sve 

što RIP renderira s točnošću u piksel i to pri velikoj brzini. Trapping se izrađuje pomoću četke, 

čime se zadržava vjernost boje i omogućuje korištenje dodatne sive boje [13].  

TrapPro također djeluje na zone preklopa i trapping parametre koji su određeni u alatima kao 

što je InDesign i koriste se u PDF ili PostScript poslovima. 

 

 

 

 



 22 

Prijelazni trapping 

 

 

 

 

 

Slika 4.3. Prijelazni trapping 

 

U slučaju kada susjedne boje imaju sličnu neutralnu gustoću, TrapPro automatski generira 

preklop boja šireći svjetliju boju u tamniju (vidi sliku 4.3.).  

 

Anamorfni trapping 

 

 

 

 

 

 

 

Slika 4.4. Anamorfni trapping 

 

Anamorfni Trapping je metoda kompenziranja različitih stupnjeva pogrešnog registra u x i y 

pravcima u procesu tiska (slika 4.4.). Trapping u ovom slučaju nadoknađuje pogreške registra u 

procesu tiska, ali fizički čimbenici koji utječu na to će vrlo često biti drugačiji u dvije osi, x i y. 

TrapPro kompenzira u različitim veličinama mogućih pogrešaka registra u obje osi.  

 

Suženi trapping 

 

 

 

 

 

 

Slika 4.5. Suženi trapping 
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Postoje slučajevi u kojima se puna širina preklopa ne uklapa u dostupno područje širenja. U 

tom slučaju, TrapPro modulira veličinu preklopa tako da pokrije dio raspoloživog prostora (slika 

4.5.).  

 

Završni izgled 

 

 

 

 

 

Slika 4.6. Završni izgled 

 

''Završni izgled'' je parametar koji definira formiranje sjecišta preklopa boja.  

 

Stupčasti trapping 

 

 

 

 

Slika 4.7. Stupčasti trapping 

 

Umjesto da koristi jednu boju kroz cijelu svoju širinu, stupčasti preklop boja postupno gubi 

svoju prvotnu boju i lagano prelazi u boju pozadine (vidi sliku 4.7.).  

 

Zaštita malih objekata 

 

 

 

 

 

 

 

 

Slika 4.8. Zaštita malih objekata 
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Crveni preklop boja prikazan na prethodnoj slici (vidi sliku 4.8.) se koristi da istakne način 

rada, a predviđen je kao pomoć u pregledu trappinga za vrijeme razvoja i podešavanja trapping 

parametra u TrapPro-u. Ova značajka zaustavlja generiranje preklopa boja koji se primjenjuje na 

neki objekt, a koji kvari izgled istog objekta. Ona štiti sve vrste objekata, uključujući i tekst.  

4.2.3. In-RIP Trapping opcije 

Opcije koje su dostupne u Trapping sekciji pod Ticket Editor, OpenRIP-a i mogu se uređivati 

na osnovi datoteka po datoteka kako bi se dobio najbolji rezultat otiska.  

 

Zadana širina preklopa (eng. Trap Width, Default): širina preklopa za boje koje se dodiruju 

trebala bi biti jednaka maksimalnoj veličini za koju se očekuje da će biti potrebna za rješavanje 

pogreške u registru tiska. Vrijednost koja je premala može omogućiti vidljivi bijeli prostor 

između susjednih boja dok je prevelika vrijednost vidljiva više nego što je to potrebno. Tipične 

vrijednosti za ofsetni tisak u idealnim uvjetima su oko 0,25 točaka. 

Širina preklopa, širina crne boje (eng. Trap Width, BlackWidth): Širina preklopa kada je 

jedna od boja crna. Također, ova vrijednost određuje ostatak vrijednosti kada ostale boje i crna 

preklapaju jedna drugu, kao što je slučaj u dubokoj crnoj. Ovdje su veće vrijednosti manje 

vidljive nego što je to u slučaju zadane širine preklopa.  

Gustoća crne (eng. BlackDensity): najveća gustoća u kojem se spot boja tretira kao crna. 

Ukoliko promijenimo vrijednost na jednaku ili manju od gustoće tamne boje dobit ćemo boju za 

koju je izrađen trapping pomoću opcije širina crne boje.  

Klizni preklop boja (eng. Sliding Trap): pomiče preklop sa tamnije strane ruba prema 

sredini. Vrijednosti između 0% i 100% su prihvatljive, ovisno o karakteristikama posla. Zadana 

vrijednost je 70%. 

Crna boja (eng. BlackColor): minimalni postotak crne tinte koja se primjenjuje na postavku 

širina crne boje (eng. BlackWidth). Preporučeno je podešavanje od 70% ili više.   

Skaliranje boje (eng. ColorScaling): određuje intenzitet tamne boje na području trappinga.  

Trapping unutar slika (eng. InternalImageTrapping): omogućuje trapping unutar slike. Ova 

postavka može biti korisna za slike sa visokim kontrastom kao što su logotipi i mape, zemljovidi, 

ali se ne smije koristiti za većinu kontinuiranih tonova. Ova opcija uvelike može povećati 

vrijeme RIP-anja, kada se koriste slike visoke rezolucije.   
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Preklop slika na objekt (eng. Trap Images to objects): Kada je odabrana ova opcija, 

trapping je dozvoljen između rasterskih slika, kao što su TIFF datoteke stavljene u dokument i 

vektorski elementi kao što su nacrtani objekti i tekst.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.9. Ilustracija trappinga između slike i objekata 

 

Način na koji su dva elementa preklopljena jedan na drugi ovisi o postavkama u padajućem 

izborniku Trap Placement:  

 Centar: trapping se javlja uz središnju liniju između slike i objekta.                        

 Upuštanje: trapping je gurnut skroz u sliku.                                              

 Normalno: trapping između objekata slijedi ista pravila kao i trappin između slike i objekta.                                                                                                         

Proširivanje: trapping je pomaknut skroz u objekt. 
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Ilustracija (vidi sliku 4.9.) prikazuje (s lijeva na desno) prvi primjer; bez trappinga, drugi 

primjer; centralni trapping, treći primjer; upuštanje teksta i proširivanje slike, četvrti primjer; 

normalni trapping i peti primjer; proširivanje teksta, upuštanje slike. 

Trapping: Postavi/ Spremi kao/Izbriši (eng. Trapping Set / Save As / Delete): nakon što je 

jednom stvorena grupa korisnih opcija, moguće ih je spremiti kao trapping postavke i one će biti 

dostupne u padajućem izborniku tako da ih je lako kasnije pronaći. Također je moguće obrisati 

opcije ili grupu opcija iz istog izbornika. 

4.3. Adobe PDF Trapper 

Adobe Portable Document Format (PDF) Trapper je autohton trapping tehnologiji koja je 

lincencirana za tvrtku  Adobe, što im omogućuje izgradnju snažnih trapping rješenja temeljenih 

na PDF-u. Adobe PDF Trapper tehnologija pruža kvalitetno generiranje preklopa boja temeljeno 

na radnom slijedu PDF-a (slika 4.10.) [1]. 

 

 

 

 

 

 

 

 

 

Slika 4.10. Radni slijed Adobe PDF Trappera 
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Prednosti PDF Trappera 

 Podrška za sve značajke dostupne u Adobe in-RIP trappingu. 

 PDF datoteke sa trappingom mogu se pregledavati u Adobe Acrobatu (5.05 i noviji) 

ili drugi preglednici koji podržavaju predpregled preklapanja boja (eng. Overprint 

previewing). 

 Sposobnost za pohranu više setova preklopa boja, svaki namijenjen drugačijem 

izlaznom uređaju. 

 Podrška za Trap One Output Many radni slijed. 

 Podrška za rukovanje naprednim opcijama boja za uređaje ovisne i uređaje neovisne o 

radnom slijedu boja. 

 Podrška za potpuno automatizirani i serijski trapping. 

 Podrška za selektivno izradu trappinga pojedinih stranica u Adobe PDF 

dokumentima. 

 Prihvaćanje trapping uputa u određenih otvorenim standardima umjesto zadanih 

kontrola trappping softvera. 

 Podrška za unutarnju i vanjsku radnu karticu. 

 Usklađenost sa Adobe PDF-om i Prijenosnim oblikom radne kartice. 

 Podrška za trapping PageMaker®, InDesign, i QuarkXpress PostScript datoteka 

destiliranih Adobe Acrobat Distiller-om. 

4.4. Trapping u DTP alatima 

Stolno izdavaštvo (eng. Desktop publishing - DTP) je izdavačka tehnika koja spaja osobno 

računalo i WYSIWYG (eng. What You See Is What You Get) alate za oblikovanje stranica sa 

kojima se stvaraju dokumenti koji se kasnije koriste za masovno tiskanje ili za ispis na lokalnom 

pisaču prije distribucije. Stolno izdavaštvo također obuhvaća sve vještine potrebne da se stvori 

tiskarski proizvod [49]. 

4.4.1. Adobe Illustrator 

Pomoću alata za za DTP trapping je moguće ručno izraditi i primijeniti trapping dodavanjem 

overprint obruba objektima ili povećanjem veličine dupliciranog objekta za veličinu trappinga.  

Adobe Illustrator je vektorski grafički editor, odnosno vektorski baziran grafički alat za 

crtanje, razvijen od strane američke tvrtke Adobe Systems [50]. 
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Kako bi bili u mogućnosti primijeniti trapping u Adobe Illustratoru potrebno je poznavati 

mogućnosti nekih paleta kao što su; paleta Stroke, Attributes, Color i Swatches (Slika 4.11.). 

 

Paleta Stroke: dodjeljuje atribute i stilove poteza 

Paleta Attributes: dodjeljuje overprint na ispunu ili potez za potrebe trappinga 

Paleta Color: koristi se za miješanje i primjenu boja na objekte, pozadine i poteze 

Paleta Swatches: pohranjuje boje i gradijente korištene u dokumentu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.11. Adobe Illustrator palete 
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 Izbijanje podloge (eng. Knockout) 

Kada se preklapaju obojeni objekti koji imaju zajedničku boju, trapping može biti nepotreban 

ukoliko boja koja im je zajednička, stvara automatski trapping. Na primjer, ukoliko dva obojena, 

preklopljena predmeta sadrže cyan kao dio svoje CMYK vrijednosti, tada će svaka praznina 

između njih biti obuhvaćena cyan sadržajem objekta ispod. Također u slučaju bijelog teksta na 

pozadini u boji nije potrebna primjena trappinga, pošto je tiskovna podloga bijela.  

 Podlaganje boja (eng. Overprint) 

Podlaganje boja u Illustratoru je prilično jednostavan postupak. Važno je znati da se crni 

tekst prema zadanoj vrijednosti definira kao overprint.  

 

Postupak: 

1. Označiti objekt s ispunom crne 

2. Otvoriti paletu Attributes (Window > Attributes) 

3. Označiti opciju Overprint Fill (vidi sliku 4.12.) 

 

 

Slika 4.12. Podlaganje boja u Illustratoru 

 

 Proširivanje i upuštanje  

U Adobe Illustratoru je moguće koristiti proširivanje (eng. spread) i upuštanje (eng. choke). 

Postupak proširivanja: 

1. Označiti objekt koji se proširuje prema pozadini 

2. Dodati obrub objektu iste boje kao i ispuna 

3. Debljinu obruba postaviti na dvostruku vrijednost debljine elementa trappinga. Pošto 

se obrub širi prema unutarnjoj i vanjskoj strani objekta. 
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4. U paleti Attributes označiti opciju Overprint Stroke (vidi sliku 4.13.). 

 

 

 

 

 

 

 

Slika 4.13. Proširivanje (eng. spread) u Illustratoru 

 

Postupak upuštanja: 

1. Označiti prednji objekt 

2. Stvoriti kopiju tog objekta i postaviti je ispred, opcijom Edit > Copy i zatim Edit > Place 

in Front 

3. Sakriti kopiju prednjeg objekta (prečac CTRL+3) 

4. Označiti pozadinski objekt i postaviti ispunu na bijelu (vidi sliku 4.14.) 

 

 

 

 

 

 

 

 

Slika 4.14. Pozadinski objekt ispunjen bijelom bojom 

 

5. Postaviti obrub objekta iste boje kao što je boja pozadine (zelena), također je potrebno 

postaviti debljinu obruba na dvostruku vrijednost debljine elementa trappinga 

6. Vratiti kopiju prednjeg objekta, Edit > Show All 

7. Označiti prednji objekt i u paleti Attributes označiti Overprint Fill (vidi sliku 4.15.) 
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Slika 4.15. Upuštanje u Illustratoru 

 

Za precizniju kontrolu trappinga i za trapping složenijih objekata, može se stvoriti efekt 

preklopne boje dodajući liniju na objekt i postaviti Overprint stroke. 

 

Postupak: 

1. Označiti prednji objekt 

2. U Stroke box-u koji se nalazi u Tools panelu ili Color panelu, napraviti sljedeće:                                                                                                       

Napraviti proširivanje tako da se unese jednaka vrijednost boja za obruba kao što je to 

već zadano u ispuni. Moguće je promijeniti vrijednost boje za obrub, odabirom opcije 

stroke, a zatim prilagođavajući vrijednosti boja u Color panelu. Ova metoda povećava 

objekt koristeći obrub koji  proširuje njezine granice sa istom bojom ispune objekta 

(vidi sliku 4.16.). 

 

 

 

 

 

 

 

 

 

 

Slika 4.16. Proširivanje (eng. spread) 
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3. Napraviti upuštanje unosom iste vrijednosti boja za obrub kao što se pojavljuju na 

svjetlijoj pozadini (opet koristeći Color panel); vrijednosti obruba i ispune će se 

razlikovati. 

Ova metoda smanjuje tamniji objekt opcijom stroke gdje svjetlija boja pozadine 

prelazi na tamniji objekt (vidi sliku 4.17.). 

 

 

 

 

 

 

 

 

 

Slika 4.17. Upuštanje (eng. choke) 

 

4. Odabrati Window > Stroke 

5. U okviru za tekst pod Weight, unijeti širinu crte. Provjeriti sa tiskarom kako bi utvrdili 

koju vrijednost koristiti. Na primjer, stroke weight od 0,6 pt stvara trapping od 0,3 pt. 

Stroke Weight od 2,0 stvara trapping od 1,0 pt (slika 4.18.). 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.18. Kreiranje stroke trappinga 
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6. Odabrati Window > Attributes > Overprint Stroke. 

Preporučljivo je povećati mjerilo grafike ukoliko to alat dozvoljava prije samog trappinga. 

Nakon što je stvoren trapping boje za neki objekt, iznos trappinga će se povećavati ili smanjivati 

ovisno o skaliranju istog objekta. Na primjer, ako stvorimo grafiku koja ima trapping od 0,5 

točaka i skaliramo je do pet puta svoje izvorne veličine, rezultat trappinga će biti 2,5 točaka za 

proširenu grafiku.   

Kod trappinga dvaju svijetlo obojana objekta, trapping linija se može pokazati kroz tamniju 

od tih dviju boja, što rezultira nastajanjem neugledne tamne granice. Na primjer, kada 

preklapamo svijetlo žuti objekt u svijetlo plavi objekt, pojavit će se svijetlo zelena linija na 

mjestu gdje je trapping korišten. Da bi spriječili izbijanje preklopne linije, moguće je odrediti 

vrijednost tona trapping boje (u ovom primjeru, žute boje) kako bi stvorili što blaži, 

zadovoljavajući učinak. 

Trapping type može uzrokovati posebne probleme. Poželjno je izbjegavati primjenu 

mješovitih procesnih boja ili tonova procesnih boja za na malu veličinu fonta, jer bilo kakva 

pogreška u tisku može napraviti tekst teško čitljivim.  

 

 Trapping naredbe 

Trapping naredbe kreiraju preklop za jednostavne objekte identificiranjem ilustracije svjetlije 

boje (bilo da je predmet ili pozadina) i pretiskivanjem u tamniju ilustraciju. Trap naredba se 

može primijeniti iz Pathfinder izbornika ili kao efekt. Prednost korištenja Trap efekta je ta da se 

trap postavke mogu promijeniti u bilo kojem trenutku.  

 

 

 

 

 

 

 

 

 

 

 

Slika 4.19. Učinak trap naredbi 
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A. Područje pretiska (eng. Overprinting) 

B. Područje izbijanja (eng. Knockout) 

C. Boja pozadine 

D. Prednja boja 

U nekim slučajevima, prednji objekt i objekt u pozadini mogu imati sličnu gustoću boje, tako 

da jedna boja nije vidljivo tamnija od druge. U tom slučaju, Trap naredba određuje trapping boje 

na temelju malih razlika u boji; ako trapping boje određen Trap naredbom nije zadovoljavajući, 

može se koristiti Obrnuti Trap koji omogućuje prebacivanje na način da Trap naredba napušta 

boju na oba objekta.  

 

Postupak: 

1. Ako je dokument u RGB modu, odabire se File > Document Color Mode > CMYK 

Color, kako bi ga pretvorili u CMYK Mode. 

2. Izabrati dva ili više objekta. 

3. Učiniti nešto od sljedećeg:                                                        

 Za primjenu naredbe direktno na objekt, odabire se Window > Pathfinder i odabere 

se Trap iz izbornika (slika 4.20.).                                                                

Za primjenu naredbe kao efekt, odabire se Effect > Pathfinder > Trap. Preview ako se 

želi pregledati efekt. 

4. Postave se Trap opcije i klikne OK. 

 

 

 

 

 

 

 

 

 

Slika 4.20. Pathfinder prozor 
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 Trapping linije [43] 

Postupak: 

1. Izabrati liniju na koju će se primijeniti trapping 

2. U Stroke box-u Tools panelu ili Color panelu, dodijeliti stroke bijelu boju 

3. U stroke panelu, izabrati željenu debljinu linije 

4. Kopirati liniju i odabrati Edit > Paste in front. Kopija je korištena kao trapping 

5. U stroke box u Tools panelu ili Color panelu, odabrati stroke kopiju sa željenom 

bojom 

6. U stroke panelu, izabrati debljinu linije koja je šira od donje linije 

7. Odabrati Window > Attributes 

8. Odabrati Overprint stroke za gornju liniju. 

 Trapping dijela objekta [43] 

Postupak: 

1. Povući liniju uz rub ili rubove na koje će se primijeniti trapping. Ako je objekt složen, 

koristiti Direct Selection tool za odabir rubova koji će se preklapati, kopirati ih i 

odabrati Edit > Paste in Fronte kako bi se kopija zalijepila izravno na original. 

2. U strokebox u Tools panelu ili Color panelu, odabrati vrijednost boje za stroke kako 

bi dobili proširenje (eng. spread) ili upuštanje (eng. choke). 

3. Odabrati Window > Attributes 

4. Izabrati Overprint Stroke. 

 Trapping opcije [43] 

 Debljina - određuje debljinu linije (eng. stroke) između 0,01 i 5000 pt. 

 Visina/širina - određuje trapping boje na vodoravnim crtama kao postotak trappinga boje 

na okomitim linijama. Određivanje različitih horizontalnih i vertikalnih trapping 

vrijednosti omogućava se nadoknada na tiskovnim nepravilnostima, kao što je na primjer 

rastezanje papira. Poželjno je kontaktirati tiskara za pomoć u određivanju tih vrijednosti. 

Zadana vrijednost od 100% rezultira u istoj širini trappping boje na vodoravnim linijama 

kao i na okomitim linijama. Kako bi povećali debljinu trappinga vodoravne linije bez 

promjene vertikalnog trappinga, potrebno je postaviti visinu/širinu na vrijednost veću od 

100%. Za smanjenje debljine trappinga vodoravnim linijama bez promjene vertikalnog 

trappinga, potrebno je postaviti vrijednost visine/širine na manju od 100% (vidi sliku 

4.21.). 
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Slika 4.21. Visina/širina trappinga postavljena na 50% (lijevo) u usporedbi sa 200% (desno) 

 

 Smanjen ton boje - smanjuje nijansu svjetlije boje na koju je primijenjen trapping; 

tamnije boje ostaju na 100%. Ova opcija je korisna kod trappinga dvaju svijetlih 

objekata, gdje se preklopna linija može prikazati kroz tamniju od dvije boje, što rezultira 

ružnom tamnom granicom. Na primjer, ako preklapamo svjetlo žuti objekt u svjetlo plavi 

objekt, na mjestu gdje se odvio trapping će se pojaviti svjetlo zelena linija. Poželjno je 

posavjetovati se s tiskarama kako bi znali koji je postotak nijanse najprikladniji s obzirom 

na vrstu tiska, tinte, zaliha papira, i tako dalje (slika 4.22.). 

 

 

 

 

 

 

 

 

 

Slika 4.22. Nijansa smanjene vrijednosti od 100%  u odnosu na nijansu smanjene vrijednosti od 50% 

 

 Trapping sa procesnom bojom – pretvorba spot boja trappinga na istovrsne procesne 

boje.  

 Obrnuti Trapping - trapping tamnije u svjetliju boju. Ova opcija ne radi sa dubokom 

crnom. 
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4.4.2. Adobe InDesign 

Adobe InDesign je alat za stolno izdavaštvo (eng. Desktop publishing) proizveden od strane 

tvrtke Adobe Systems. Koristi se za kreiranje plakata, letaka, brošura, časopisa, novina i knjiga. 

Cijenjen zahvaljujući raznim mogućnostima spajanja tekstova, slika i ilustracija u konačni 

proizvod bilo da je on namijenjen tiskanom ili digitalnom izdavaštvu [51,52]. 

 Pregled Panela Trap postavki 

Trap postavka je skup trapping postavki koje se mogu primijeniti na stranicu ili raspon 

stranica u dokumentu. Panel Trap postavki osigurava sučelje za unos i spremanje postavki 

trappinga. Trap postavke se mogu primijeniti na bilo koju stranicu u dokumentu ili uvesti 

postavke iz drugog InDesign dokumenta [28].    

 

Za promjenu zadanih postavki i primjenu istih, potrebno je: 

1. Odabrati Window > Output > Trap Presets(Slika 4.23.). 

2. Dvostruki klik na Default. 

 

 

 

 

 

 

 

 

 

 

Slika 4.23. Dijaloški okvir trap opcija 

 

3. Promijeniti trap opcije, (ukoliko to nije moguće, posavjetovati se sa print providerom) i 

kliknuti OK kako bi zatvorili dijaloški okvir. 

4. U okviru trap postavki, izabrati nove postavke. 

5. Upisati odgovarajući naziv za novu trap postavku. 
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6. Pregledati i napraviti promjene u novom dijaloškom okviru. 

Postavke se mogu promijeniti pomoću ovih opcija: 

Širina preklopa boje (eng. Trap Width): zadana vrijednost određuje širinu preklopa za 

bilo koju tintu, osim crne. Vrijednost crne se unosi u zasebno polje. 

Slike: kontrolira kako InDesign rukuje trappingom između elemenata u dokumentu i bilo 

kakve uvezene grafike na njega. 

Izgled trappinga: opcija za precizno podešavanje i promjenu izgleda kuteva preklopa 

boje.                                                                                 

 Granične vrijednosti: kontrolira kako InDesign kreira preklop između dviju boja u 

dokumentu. 

7. Pritisnuti U redu kako bi kreirali trap postavku. 

 

 Kreiranje pretiska 

Postupak: 

1. Kako bi kreirali pretisak u InDesignu potrebno je odabrati najviši objekt od dva ponuđena 

koji će se preklapati jedan u drugoga. 

2. Zatim odabrati Window > Output > Attributes i u dijaloškom okviru odabrati opciju 

Overprint Fill. Kako bi vidjeli kako ta opcija radi, odaberemo View > Overprint Preview.                                                      

Isključimo Overprint Fill(slika 4.24.). 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.24.Primjena OverprintFill opcije na crveni objekt 
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3. U izborniku Stroke odaberemo boju jednaku ispuni i debljinu linije 10 pt (slika 4.25.). 

 

 

 

 

 

 

 

 

 

Slika 4.25.Kreiranje stroke trapa 

 

4. U izborniku Window pod Output odaberemo Attributes i opciju Overprint Stroke i 

Overprint Fill. 

5. Na kraju isključimo opciju Overprint Stroke. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.26. Podlaganje crvenog na plavi objekt 
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 Trapping na tekst 

Postupak 

1. Kako bi se kreirao trapping potrebno je otvoriti paletu Trap Presets iz Output opcije u 

Window izborniku (vidi sliku 4.23.). 

2. U otvorenom Trap presets prozoru odabrati New preset iz izbornika u gornjem desnom 

kutu (vidi sliku 4.27.). 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.27. Kreiranje trapa 

 

3. Nakon odabira postavki potrebno ih je primijeniti na tekst. Ponovo koristimoTrap presets 

prozor i u gornjem desnom kutu se odabere Asign trap preset u kojem se odaberu 

spremljene opcije, klikne na Asign i nakon toga Done (slika 4.28.). 

 

 

 

 

 

 

 

 

 

 

Slika 4.28. Odabir novokreiranog trapa 



 41 

4. U izborniku Stroke povećati debljinu linije. Zatim otvoriti paletu Attributes iz Output 

opcije u Window izborniku i odabrati Overprint Stroke na selektirani tekst (slika 4.29.). 

 

 

 

 

 

 

 

Slika 4.29. Izgled teksta prije i nakon trappinga 

 

 Automatski trapping 

InDesign zbog svoje raznolikosti i moćnih postavki ima mogućnost primjene automatskog 

trappinga putem aplikacijskog built-in trappinga. Postavke za kontrolu ovog procesa se nalaze u 

paleti Trap Presets [6]. 

 

Postupak:  

1. Odabrati Window > Output > Trap Presets, nakon čega se odabrana paleta otvara u 

novom prozoru 

2. U izborniku palete Trap Presets odabrati New Preset (slika 4.30.). 

 

 

 

 

 

 

 

 

 

 

Slika 4.30. Paleta Trap Presets 
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3. Unutar okvira New Trap Preset potrebno je konfigurirati postavke na željene vrijednosti, 

poželjno je pravilno imenovati novo kreirani Trap Preset i potom odabrati OK (slika 

4.31.) 

 

 

 

 

 

 

 

 

 

 

Slika 4.31. Okvir New Trap Preset 

 

Unutar okvira New Trap Presets moguće je izvršiti promjene djelujući na sljedeće opcije:  

 Trap Width [48] 

VrijednostDefault određuje debljinu trappinga za bilo koju boju, osim crne, koja se 

koristi u dokumentu. Vrijednost debljine trappinga za crnu se unosi unutar okvira Black. 

 Trap Appearance [48] 

Određivanje stila spoja trappinga preko padajućeg izbornika opcije Join Style (vidi sliku 

4.32.); određivanje stila završetka trappinga preko padajućeg izbornika opcije End Style 

(vidi sliku 4.33.) 

 

 

 

 

 

 

Slika 4.32. Stilovi spoja trappinga 
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Slika 4.33. Stilovi završetka trappinga 

 

 Trap Tresholds [48] 

Kontrola kako InDesign primjenjuje trapping na područja između dviju boja u 

dokumentu. Moguće je utjecati da li će InDesign primijeniti trapping na dva objekta 

sličnih boja (npr. koliko različite bi boje trebale biti da bi InDesign primijenio trapping). 

 

4. U izborniku palete Trap Presets odabrati Assign Trap Preset 

5. Odabrati stil trappinga koji će biti primijenjen, unijeti raspon stranica na koje će biti 

primijenjen isti i odabrati Assign. Zatim je potrebno pohraniti promjene preko ikone 

Done (slika 4.34.) 

 

 

 

 

 

 

 

 

 

 

Slika 4.34. Okvir Assign Trap Presets 
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6. U dijaloškom okviru Print (File > Print) potrebno je odabrati Output na izborniku s 

lijeve strane, te postaviti opciju Color na In-RIP Seperations i opciju Trapping na 

Applicatio Built-In (slika 4.35.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.35. Dijaloški okvir Print 

 

7. Dokument izvesti u pdf formatu. 
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4.4.3. Adobe Photoshop 

Adobe Photoshop je grafički alat, razvijen i izdan od strane američke tvrtke Adobe Systems. 

Slovi kao najpoznatiji računalni program za obradu slika [53]. 

Primjenjujući trapping u Photoshopu često se susrećemo sa radom s posebnim bojama koje 

iziskuju dodatnu pažnju kako bi se ispravno preklopile jedna s drugom ili s postojećim kanalima 

boje.                                        

 Spot boje su posebno miješane boje koje se koriste umjesto ili kao dodatak procesnim 

bojama (CMYK). Svaka spot boja zahtijeva svoju vlastitu ploču u tisku. U slučaju ispisa slika sa 

spot bojama, potrebno je stvoriti spot kanale za pohranu boja (vidi sliku 4.36.) Za izvoz spot 

kanala, potrebno je spremiti sliku u DCS 2.0 format ili PDF.  

 

Obratiti pozornost na sljedeće prilikom rada sa spot bojama:  

1. Kako bi primijenili spot boju kao nijansu preko cijele slike, potrebno je konvertirati sliku 

u dvobojni način rada i primijeniti spot boju na jednu od dvobojnih ploča. Moguće je 

koristiti do četiri spot boja na jednu ploču. 

2. Imena spot boja ispisuju se na separaciji 

3. Spot boje su otisnute na vrhu potpune kompozicije slike. Svaka spot boja se ispisuje po 

redu kako se i pojavljuje u kanalima ploča. 

4. Nemoguće je premjestiti spot boje u iznad zadanog kanala u Kanalima ploča, osim u Više 

kanalnom načinu rada 

5. Spot boje se ne mogu primijeniti na zasebne slojeve 

6. Moguće je spojiti spot kanale sa kanalom boje, pri čemu će se spot boja podijeliti u svoje 

vlastite komponente boje. 

Moguće je stvoriti novi spot kanal ili konvertirati postojeći alfa kanal u spot kanal. 

 Kreiranje novog spot kanala 

Postupak: 

1. Odabrati Window > Channels za prikaz okvira kanala 

2. Za popunjavanje odabranog područja sa spot bojom, napraviti ili učitati selekciju 

3. Učiniti nešto od sljedećeg za izradu kanala: 

CTRL klik na tipku New channel u Channels panel ili odabrati New Spot Channel u 

izborniku Channels panel(slika 4.36.) 
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Slika 4.36. Kreiranje novog spot kanala 

 

4. U dijaloškom okviru New Spot Channel, kliknuti na okvir za boju. U biblioteci boja 

izabrati između ponuđenih sustava boja Pantone ili Toyo (slika 4.37.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.37. Biblioteka boja 

 



 47 

5. Unijeti naziv spot kanala. Ukoliko je preuzeta jedna od prilagođenih boja, kanal će 

automatski preuzeti ime te boje. 

6. Za čvrstoću unijeti vrijednost između 0 i 100%. Ova opcija omogućuje simulaciju na 

zaslonu, gustoću tiskane spot boje. Vrijednost od 100% simulira tintu koja u 

potpunosti pokriva tintu ispod (kao što je metalik tinta); 0% simulira transparentnu 

tintu koja potpuno otkriva tintu koja se nalazi ispod (kao što je čisti lak). Također, ovu 

opciju je moguće koristiti kako bi vidjeli gdje će se pojaviti neki drugi način 

transparentne spot boje (slika 4.38.). 

 

 

 

 

 

 

 

Slika 4.38. Čvrstoća na 100% (lijevo) i 50% (desno) 

 

 Pretvorba alfa kanala u spot kanal 

1. Ako je odabrana slika, kliknuti na Select > Deselect 

2. Učiniti nešto od sljedećeg: 

Dvaput kliknuti na alfa kanal u Channels panelu. 

Izabrati alfa kanal u Channels panelu, te odabrati Channel Options iz panel menija. 

3. Odabrati spot boju 

4. Kliknuti na okvir boja, odabrati jednu od boja u paleti ili kliknuti na biblioteku boja i 

odabrati prilagođenu boju 

5. Preimenovati kanal ukoliko je to potrebno i pritisnuti OK. Područja kanala koji su 

sadržavali tonove sive tonove će se pretvoriti u spot boje 

6. Za primjenu boje na odabrano područje odabrati Image > Adjustments > Invert. 
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 Kreiranje trappinga 

1. Kreiraju se dva objekta jedan povrh drugoga, oba ispunjena spot bojom. Kako bi 

odabrali gornji objekt odaberemo CTRL + klik. 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.39. Otvaranje prozora stroke 

 

2. Zatim se odabere Edit > Stroke, pojavi nam se prozorčić u kojem se mogu mijenjati 

veličina trappinga, boja, lokacija trappinga. U ovom slučaju je odabran trapping plave 

spot boje, debljine 8 px iz centra (slika 4.39.) 

3. Što zapravo znači da smo povećali objekt za samo 4 px, zato što pola odabranog 

piksela ide na trenutni objekt a pola izvana (vidi sliku 4.40.). 

 

 

 

 

 

 

 

 

 

 

 

Slika 4.40. Izgled objekta prije i nakon trappinga 
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4.5. Softver za automatski trapping 

Automatski trapping, kao što samo ime govori, izračunava relativne razine tamnoće/svjetline 

(ili neutralne gustoće) na rubovima grafika i potom primjenjuje trapping na način da se proširuje 

svjetlija prednja boja prema tamnijoj pozadini ili sužava svjetlija pozadina prema tamnijoj 

prednjoj [6].  

Različite metode trappinga se primjenjuju na različite dijelove objekta, čak i ako je objekt 

smješten preko nekoliko različitih boja pozadine. Trapping se dodaje automatski [54]. 

Poznatiji softver za Adobe Illustrator jest Esko Power Trapper. Power Trapper postoji kao 

samostalni modul ili kao klijent server. Najčešće dolazi u obliku plug-ina za automatski trapping 

u Adobe Illustratoru [55]. 

 

 

 

 

 

 

 

 

 

 



 50 

5. Primjeri izrade trappinga u DTP alatima 

Cilj praktičnog dijela rada je prikazati primjere izrade trappinga pomoću DTP alata na 

konkretnim primjerima ambalažnih proizvoda za tisak, sukladno sa teorijskim dijelom i načinom 

izrade trappinga u svakom pojedinačnom alatu na automatski i manualni način. Alati korišteni za 

izradu i primjenu trappinga su Adobe Illustrator CS6, Adobe InDesign CC 2014 i Adobe 

Photoshop CS5. Izrada trappinga je prikazana kroz dva primjera u svakom pojedinom alatu, uz 

pojašnjenje i detaljnu razradu svakog primjera.  

 

Od ambalažnih proizvoda obrađene su etikete, kartonske kutije, fleksibilne etikete i omoti.  

Praktični dio zadatka je organiziran na sljedeći način: 

 Primjena trappinga u Adobe Illustratoru 

- Etiketa “CEKIN – Grill pile” 

- Etiketa za pivo “PAN bez alkohola” 

 Primjena trappinga u Adobe InDesignu 

- Kartonska kutija “LUPOCET” 

- Fleksibilna etiketa “PANNON” 

 Primjena trappinga u Adobe Photoshopu 

- Fleksibilna etiketa “Cekin – Poliko” 

- Etiketa za pivo “Carlsberg” 
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5.1. Primjena trappinga u Adobe Illustratoru 

5.1.1. Etiketa „Cekin – Grill pile“ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 5.1. Izgled etikete „CEKIN – Grill pile“ 

 

 

Redoslijed boja u tisku: 
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Slika 5.2. Usporedba trappinga etikete „CEKIN – Grill pile“ 

- zlatna boja je otisnuta overprint iz 

razloga jer se ona tiska tehnikom 

vrućeg tiska pomoću zlatne folije koja 

je pokrivna na sve podložne elemente 

- zlatni obrub je postavljen overprint na 

način da se pola debljine linije 

preklapa preko zelene ispune, a pola 

preko podložne crvene 

Manualni trapping Automatski trappping 

- upuštanje žute boje pozadine 

prema tamnijem zelenom 

objektu, svim elementima zelene 

boje dodana je linija debljine 

0,075 mm, overprint, žuta 

- trapping  narančaste prema  žutoj podložnoj 

boji, dodana je linija debljine 0,075 mm, 

overprint, narančasta 

- crvena boja (100% M + 100% Y + 10% K) se 

postavlja overprint iz razloga što je  dovoljno 

tamna da u tisku pokrije podložnuboju 

- upuštanje svjetlije pozadine u tamniji 

objekt kod automatskog trappinga 

- u manualnom načinu se ne događa ništa 
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5.1.2. Etiketa za pivo „PAN bez alkohola“ 

Redoslijed boja u tisku: 

 

 

 

 

Vratna etiketa 

 

 

 

 

 

Prednja etiketa 

 

 

 

 

 

 

 

 

 

Stražnja etiketa 

 

 

 

 

 

 

 

 

 

 

Slika 5.3. Izgled kompleta etiketa za pivo „PAN bez alkohola“ 
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Etiketa se tiska na metalizirnom papiru pa se iz tog razloga sve boje podlažu bijelom bojom, 

osim na mjestima gdje je dizajnom zamišljeno da se vidi metalizirani sjaj papira.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Slika 5.4. Usporedba trappinga etikete za pivo „PAN bez alkohola“ 

- podložna, bijela boja koja se 

nalazi ispod obojenih elemenata, 

sužena je  za 0,1 mm, iz razloga 

da se uslijed pogreške u registru 

tiska bijela boja ne bi pojavila na 

rubovima elemenata 

- podložna bijela boja teksta se upušta u 

crvenu boju (PANTONE 485 C)  na način 

da se svima elementima obojenim bijelom 

bojom dodaje linija debljine 0,2 mm 

- pozadinska boja (PANTONE 356 C)            

je podložena s bijelom 

- crni obrub je stavljen overprint 

- crvena se stavlja generalno 

overprint jer je dovoljno 

pokritna i tamna da u tisku 

prekrije podložnu boju, a da 

se nijansa crvene značajno 

ne promijeni 

- crna je stavljena overprint 

- na mjestima bez obojenja vidljiv 

je metalizirani sjaj papira 

     Manualni trapping  Automatski trapping 
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5.2. Primjena trappinga u Adobe InDesignu 

5.2.1. Kartonska kutija „Lupocet“ 

Redoslijed boja u tisku: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 5.5. Izgled kartonske kutije „LUPOCET“ 
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Slika 5.6. Usporedba trappinga kartonske kutije „LUPOCET“ 

- u slučaju dodirivanja procesnih 

boja, magente (100% M) i 

zelene (94% C + 42% Y) nema 

zajedničkih boja 

- kako nebi došlo do pojave 

bjelina između navedenih boja 

uslijed pogreške registra tiska,  

zelena se preklapa prema 

magenti dodavanjem linije 

debljine 0,075 mm, overprint, 

zelena 

Manualni trapping Automatski trapping 

- podloga je u cijan boji (100% C), dok je 

tekst u magenti (100% M). S obzirom da 

nemaju određeni postotak zajedničkih 

boja, tekst se preklapa prema  podlozi 

dodavanjem linije debljine 0,075 mm, 

overprint, magenta 
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5.2.2. Fleksibilna etiketa „PANNON“ 

Redoslijed boja u tisku: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

Slika 5.7. Izgled fleksibilne etikete „PANNON“ 
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Slika 5.8. Usporedba trappinga fleksibilne etikete „PANNON“ 

 

Manualni trapping Automatski trapping 

- Crveni element (PANTONE 485) se 

preklapa prema svim podložnim bojama 

(PANTONE 457 i PANTONE 3415), 

dodavanjem linije debljine 0,1 mm, 

overprint, crvena 

- Trapping zelene radi se 

dodavanjem linije debljine 0,35 

mm, overprint, zelena boja 

- Bijela se prema zadanoj vrijednosti  

izbija (eng. knockout) 
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5.3. Primjena trappinga u Adobe Photoshopu 

5.3.1. Fleksibilna etiketa „CEKIN – Poliko“ 

Redoslijed boja u tisku:                                  

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Slika 5.9. Izgled fleksibilne etikete „CEKIN – Poliko“ 
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Slika 5.10. Usporedba trappinga fleksibilne etikete „CEKIN – Poliko“ 

 Manualni trapping   Automatski trapping 

- bijeli tekst je prema zadanoj 

vrijednosti izbijen iz podloge 

- Crveni objekt se preklapa 

prema podložnoj zelenoj 

dodavanjem linije debljine 0,2 

mm, overprint, crvena 

- Bijeli tekst se proširuje prema 

crvenom objektu dodavanjem 

linije debljine 0,2 mm 

- Proširivanje žute (PANTONE 

123) prema podložnoj zelenoj 

- Proširivanje žutog trappinga 

cvijeta je primijenjeno iz 

razloga da se uslijed pogreške u 

registru tiska bijela boja ne bi 

pojavila na rubu elemenata 

- crvena se preklapa prema podložnoj 

zelenoj boji, dodavanjem linije debljine 

0,075 mm, overprint, crvena 

- crvena se ne preklapa na podložnoj bijeloj 

boji iz razloga što je dovoljno pokrivna, 

bijeli sloj se prema zadanoj vrijednosti 

izbija iz podloge 

bez overprinta                 overprint 
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5.3.2. Etiketa za pivo „Carlsberg“ 

Redoslijed boja u tisku: 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 5.11. Izgled etikete za pivo „Carlsberg“ 
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Slika 5.12. Usporedba trappinga etikete za pivo „Carlsberg“ 

- žuti element (PANTONE 1242) 

se preklapa prema podložnoj 

zelenoj (PANTONE 349) 

dodavanjem linije debljine 0,15 

mm, overprint, žuta 

Manualni trapping      Automatski trapping    

- trapping bijele boje prema 

podlozi (PANTONE 349) radi 

se dodavanjem linije debljine 

0,1 mm, overprint, bijela 

- crna se generalno stavlja 

overprint 

- Trapping print bijele prema podlozi 

(PANTONE 349) radi se dodavanjem 

linije debljine 0,15 mm, overprint, bijela 

- Trapping žute (PANTONE 1242)  na 

podložnu zelenu  radi se dodavanjem  

linije debljine 0,15 mm, overprint, žuta 

- Tekst crne boje je stavljen kao overprint 

crne iz razloga što se crna prema zadanoj 

vrijednosti uvijek stavlja overprint 
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6. Zaključak 

Kako je već poznato u tiskarskoj struci, teško je postići i zadržati savršenu razinu tiska bez 

pogrešaka u registru tiska. U praksi je nemoguće ostvariti tisak bez utjecaja lošeg registra za 

svaki objekt na pojedinoj tiskovnoj podlozi, bilo to uzrokovano nekim ljudskim faktorom ili 

tehničke prirode. Prilikom tiska gotovo uvijek nastaju neželjena odstupanja u registru tiska, stoga 

uvođenje trappinga kao metode eliminacije neželjenih odstupanja, ima važnu ulogu u grafičkoj 

pripremi svih grafičkih proizvoda kako bi se u konačnici dobio kvalitetan proizvod.  

 

Ukoliko dođe do potrebe korištenja trappinga, postoji nekoliko načina, ručno pomoću DTP 

alata, pomoću softvera za automatski trapping i In-RIP trapping. Najčešće korištena tehnika jest 

automatski trapping, iz razloga što iziskuje manje znanja, efikasnija je i puno brža. Međutim, 

uvijek postoji mogućnost da se i automatskom trappingu ''podvuče'' pokoja pogreška ili javi 

problem koji ne može riješiti, tada koristimo ručni trapping. Premda ručni trapping 

podrazumijeva određeno znanje i vještinu korištenja programa za oblikovanje stranica kao što su 

DTP alati, ističe se kao najsigurniji i najtočniji način izrade trappinga kod izrade ambalaže. 

Proces izrade i primjene trappinga zahtjeva puno iskustva i znanja o procesu tiska, kako bi isti 

mogao biti uspješno sproveden. Dakle, prije shvaćanja kako primijeniti i izraditi trapping 

potrebno je razumjeti zašto se i na koji način uopće trapping primjenjuje.  

 

Ovim završnim radom pokazan je usporedni postupak ručne izrade trappinga pomoću Adobe 

DTP alata te automatski pomoću Esko Power trappera, na primjerima ambalažnih grafičkih 

proizvoda.  

 

 

 

 

 

 

 

 

           U Varaždinu, 29. rujna 2015. 
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8. Popis slika 

Slika 1.1. Pogreška u registru tiska bez primjene trappinga i sa trappingom                                                                                                                                 

(izvor:https://www.xchangeuk.com/designing-for-print-vs-screen-part-iv-preflighting-and-

submitting-files-for-print/) 

Slika 2.1. Izbijanje podloge (eng. knockout) 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.2. Preklapanje boja 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.3. Utjecaj bijele boje na crnoj pozadini 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.4. Eliminacija utjecaja tolerancije registra tiska 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.5. Primjer trappinga jednog gradijenta na drugi 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.6. Prijelazni trapping 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.7. Trapping gradijenta procesnih boja i trapping slike u gradijent  

procesne boje (izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 2.8. Trapping slike na pozadini druge slike 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 3.1. Kompenzacija praznina i pomaka boje 

(izvor:http://ekaprint.net/6trappingbasics.html) 

Slika 3.2. Podlaganje boja (eng. overprint) 

(izvor:http://ekaprint.net/6trappingbasics.html) 

Slika 3.3. Izgled objekta sa overprintom i bez overprinta 

(izvor:https://helpx.adobe.com/indesign/using/overprinting.html) 

Slika 3.4. Izbijanje podloge (eng. knockout) 

Slika 3.5. Proširivanje 

(izvor:https://helpx.adobe.com/illustrator/using/trapping.html) 

Slika 3.6. Upuštanje 

(izvor:https://helpx.adobe.com/illustrator/using/trapping.html) 

Slika 3.7. Određivanje svjetlije/tamnije boje 

(izvor:http://www.trapping.org/tips.html) 

Slika 3.8. Upotreba procesnih boja s određenim postotkom zajedničkih boja 

(izvor:http://www.trapping.org/tips.html) 

Slika 3.9. Upotreba procesnih boja s malim postotkom zajedničkih boja 

(izvor:http://www.trapping.org/tips.html) 
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Slika  4.1. Radni slijed Adobe trappinga 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 4.2. Radni slijed Adobe In-RIP trappinga 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 4.3. Prijelazni trapping 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.4. Anamorfni trapping 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.5. Suženi trapping 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.6. Završni izgled 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.7. Stupčasti trapping 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.8. Zaštita malih objekata 

(izvor:http://www.globalgraphics.com/technology/trapping/) 

Slika 4.9. Ilustracija trappinga između slika i objkata 

(izvor:http://www.xante.com/product-information/workflow-solutions/symphony-

workflow/in-rip-trapping/) 

Slika 4.10. Radni slijed Adobe PDF Trappera 

(izvor: http://www.adobe.com/studio/print/pdf/trapping.pdf) 

Slika 4.11. Adobe Illustrator palete 

Slika 4.12. Podlaganje boje u Illustratoru 

Slika 4.13. Proširivanje (eng. spread) u Illustratoru 

Slika 4.14. Pozadinski objekt ispunjen bijelom bojom 

Slika 4.15. Upuštanje u Illustratoru 

Slika 4.16. Proširivanje (eng. spread) 

Slika 4.17. Upuštanje (eng. choke) 

Slika 4.18. Kreiranje stroke trappinga 

Slika 4.19. Učinak trap naredbi  

          (izvor:https://helpx.adobe.com/illustrator/using/trapping.html) 

Slika 4.20. Pathfinder prozor 

Slika 4.21. Visina/širina trappinga postavljena na 50% (lijevo) u usporedbi sa 200% (desno)  

(izvor:https://helpx.adobe.com/illustrator/using/trapping.html) 

Slika 4.22. Nijansa smanjene vrijednosti od 100% u odnosu na nijansu  

smanjene vrijednosti od 50% 

(izvor:https://helpx.adobe.com/illustrator/using/trapping.html) 

Slika 4.23. Dijaloški okvir trap opcija 

http://www.adobe.com/studio/print/pdf/trapping.pdf
http://www.adobe.com/studio/print/pdf/trapping.pdf
http://www.globalgraphics.com/technology/trapping/
http://www.globalgraphics.com/technology/trapping/
http://www.globalgraphics.com/technology/trapping/
http://www.globalgraphics.com/technology/trapping/
http://www.globalgraphics.com/technology/trapping/
http://www.globalgraphics.com/technology/trapping/
http://www.xante.com/product-information/workflow-solutions/symphony-workflow/in-rip-trapping/
http://www.xante.com/product-information/workflow-solutions/symphony-workflow/in-rip-trapping/
http://www.adobe.com/studio/print/pdf/trapping.pdf
https://helpx.adobe.com/illustrator/using/trapping.html
https://helpx.adobe.com/illustrator/using/trapping.html
https://helpx.adobe.com/illustrator/using/trapping.html


 68 

Slika 4.24. Primjena Overprint Fill opcije na crveni objekt  

Slika 4.25. Kreiranje stroke trapa 

Slika 4.26. Podlaganje crvenog na plavi objekt 

Slika 4.27. Kreiranje trapa 

Slika 4.28. Odabir novokreiranog trapa 

Slika 4.29. Izgled teksta prije i nakon trappinga 

Slika 4.30. Paleta Trap Presets 

Slika 4.31. Okvir New Trap Preset 

Slika 4.32. Stilovi spoja trappinga 

(izvor:https://helpx.adobe.com/indesign/using/trap-presets.html) 

Slika 4.33. Stilovi završetka trappinga 

(izvor:https://helpx.adobe.com/indesign/using/trap-presets.html) 

Slika 4.34. Okvir Assign Trap Presets  

Slika 4.35. Dijaloški okvir Print 

Slika 4.36. Kreiranje novog spot kanala 

Slika 4.37. Biblioteka boja 

Slika 4.38. Čvrstoća na 100% (lijevo) i 50% (desno) 

(izvor:https://helpx.adobe.com/photoshop/using/printing-spot-colors.html) 

Slika 4.39. Otvaranja prozora stroke 

Slika 4.40. Izgled objekta prije i nakon trappinga 

Slika 5.1. Izgled etikete „CEKIN – Grill pile“ 

Slika 5.2. Usporedba trappinga etikete „CEKIN – Grill pile“ 

Slika 5.3. Izgled kompleta etiketa za pivo „PAN bez alkohola 

Slika 5.4.  Usporedba trappinga etikete za pivo „PAN bez alkohola“ 

Slika 5.5.  Izgled kartonske kutije „LUPOCET“ 

Slika 5.6. Usporedba trappinga kartonske kutije „LUPOCET“ 

Slika 5.7. Izgled fleksibilne etikete „PANNON“ 

Slika 5.8. Usporedba trappinga fleksibilne etikete „PANNON“ 

Slika 5.9. Izgled fleksibilne etikete „CEKIN – Poliko“ 

Slika 5.10. Usporedba trappinga fleksibilne etikete „CEKIN – Poliko“ 

Slika 5.11. Izgled etikete za pivo „Carlsberg“ 

Slika 5.12. Usporedba trappinga etikete za pivo „Carlsberg“ 
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